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Preface

This guide provides introductory information for SQL*Plus for Windows NT and 
Windows 95/98.

Specific topics discussed in this preface are:

■ Prerequisites

■ Intended Audience

■ How This Guide Is Organized

■ Conventions
vii



Prerequisites
This guide assumes that you are familiar with:

■ Commands for deleting and copying files and the concepts of the search path, 
subdirectories, and path names.

■ Fundamentals of the Microsoft Windows NT or Windows 95/98 operating 
system.

Intended Audience
This guide is for all users who want to use SQL*Plus in the Windows NT or 
Windows 95/98 environment.

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Introducing SQL*Plus"
Provides introductory information to help you get started with SQL*Plus for 
Windows NT and Windows 95/98.

Chapter 2, "Using SQL*Plus"
Explains how to start and use SQL*Plus from the command line interface and 
the graphical user interface, and describes the menu options.

Chapter 3, "Operating System-Specific References"
Provides the operating system-specific information that is cross-referenced in 
the SQL*Plus User’s Guide and Reference.

Appendix A, "Customizing Operating System Parameters"
Describes how to customize your SQL*Plus configuration by changing 
parameters in the registry.
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Conventions
The following conventions are used in this guide.

Convention Example Meaning

All uppercase plain ALTER DATABASE Indicates command names, SQL reserved 
words, and keywords. All uppercase 
plain is also used for directory names 
and file names.

Italic Italic used to indicate a variable:

ORACLE_HOME\filename

Italic used for emphasis:

The WHERE clause may be used to join 
rows in different tables.

Indicates a value that you must provide. 
For example, if a command asks you to 
type filename, you must type the actual 
name of the file.

Italic is also used for emphasis in the text 
and to indicate the titles of other guides.

Oracle database The database component of Oracle8.

C:\> C:\>ORANT\DATABASE Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt can differ and can, at times, 
reflect the subdirectory in which you are 
working. Referred to as the MS-DOS 
command prompt in this guide.

Backslash (\) before a 
directory name

\DATABASE Indicates that the directory is a 
subdirectory of the root directory.

Oracle home Go to the ORACLE_HOME\DATABASE 
directory.

Oracle home is represented as the hard 
drive letter and the top level directory 
where your Oracle software is installed. 
In this guide, the convention ORACLE_
HOME is used to indicate your Oracle 
home directory, which may be:

■ C:\ORANT for Windows NT

■ C:\ORAWIN95 for Windows 95

■ C:\ORAWIN98 for Windows 98

or whatever you may have called your 
Oracle home.
ix



HOME_NAME OracleHOME_NAMETNSListener Represents the Oracle home name if you 
use multiple Oracle homes. This 
convention is not applicable for a single 
Oracle home.

The home name can be up to sixteen 
alphanumeric characters. The only 
special character allowed in the home 
name is the underscore. 

Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
x
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Introducing SQL*Plus

This chapter provides introductory information to help you get started with 
SQL*Plus for Windows NT and Windows 95/98.

Specific topics discussed are:

■ Overview

■ Basic Concepts

■ Who Can Use SQL*Plus?

■ Installing SQL*Plus
*Plus 1-1



Overview
Overview
You can use the SQL*Plus program in conjunction with the SQL database language 
and its procedural language extension, PL/SQL. The SQL database language allows 
you to store and retrieve data in Oracle databases. PL/SQL allows you to link 
several SQL commands through procedural logic.

SQL*Plus enables you to manipulate SQL commands and PL/SQL blocks, and to 
perform many additional tasks as well. Through SQL*Plus, you can:

■ enter, edit, store, retrieve, and run SQL commands and PL/SQL blocks

■ format, perform calculations on, store, and print query results in the form of 
reports

■ list column definitions for any table

■ access and copy data between SQL databases

■ send messages to and accept responses from an end user

SQL*Plus for Windows NT and Windows 95/98 provides both a command line 
interface and a graphical user interface (GUI).

Basic Concepts
The following definitions explain concepts central to SQL*Plus: 

Concept Definition

command An instruction you give SQL*Plus or Oracle.

SQL command A command to execute SQL statements.

SQL*Plus command A command to execute SQL*Plus statements.

block A group of SQL and PL/SQL commands related to one 
another through procedural logic.

table The basic unit of storage in Oracle.

query A SQL command (specifically, a SQL SELECT command) 
that retrieves information from one or more tables.

query results The data retrieved by a query. 

report Query results formatted by you through SQL*Plus 
commands.

SQL buffer A buffer to store the last SQL statement that has been 
executed in SQL*Plus.
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Installing SQL*Plus
For definitions of other concepts that are relevant to SQL*Plus, see the glossary in 
SQL*Plus User’s Guide and Reference.

Who Can Use SQL*Plus?
The SQL*Plus, SQL, and PL/SQL command languages are powerful enough to 
serve the needs of users with some database experience, yet straightforward enough 
for new users who are just learning to work with Oracle.

The design of the SQL*Plus command language makes it easy to use. For example, 
to give a column labelled ENAME in the database the clearer heading "Employee", 
you might enter the following command:

COLUMN ENAME HEADING EMPLOYEE

Similarly, to list the column definitions for a table called EMP, you might enter this 
command:

DESCRIBE EMP

Installing SQL*Plus
The CD-ROM insert that accompanies your product CD-ROM contains the 
following information:

■ System requirements for SQL*Plus

■ Instructions on how to install SQL*Plus

Installation of SQL*Plus release 8.0 does not overwrite previous versions of 
SQL*Plus that are installed. Therefore, more than one version of SQL*Plus can exist 
on the same computer. However, you may want to remove any previous versions.

screen buffer A buffer to store the data in the SQL*Plus application 
window.

Concept Definition
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Using SQL*Plus

This chapter explains how to start and use SQL*Plus from the command line 
interface and the graphical user interface, and describes the menu options.

Specific topics discussed are:

■ Using the Command Line Interface

■ Using the Graphical User Interface

■ Using SQLPLUS.EXE
*Plus 2-1



Using the Command Line Interface
Using the Command Line Interface
The command line interface is a standard feature of SQL*Plus for all platforms.

To start the command line interface:

1. If you are connecting to a remote Oracle database, make sure your 
Net8/networking software is installed and working properly.

2. Start an MS-DOS command prompt window.

3. At the command prompt, enter:

SQLPLUS [ username/password ][@net_service_name ]

For Windows NT and Windows 95/98, the rules for interpreting arguments are:

■ Arguments are delimited by white space.

■ A string surrounded by double quotation marks (for example, "string") is 
interpreted as a single argument.

■ A double quotation mark preceded by a backslash is interpreted as a literal 
double quotation mark.

Using the Graphical User Interface
The graphical user interface is a feature of SQL*Plus for Windows NT and Windows 
95/98.

To start the graphical user interface:

1. If you are connecting to a remote Oracle database, make sure your 
Net8/networking software is installed and working properly.

2. Choose Start > Programs > Oracle for Windows NT [HOME_NAME] (or Oracle 
for Windows 95/98 [HOME_NAME]) > SQL Plus 8.0.

The Log On dialog appears.
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Using the Graphical User Interface
3. Enter your user name and password. If you are connecting to a remote Oracle 
database, enter the Net8 service name.

4. Click OK.

The SQL*Plus application window appears.
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Using the Graphical User Interface
Using the SQL*Plus Application Window
SQL*Plus displays the SQL prompt in the application window.

To enter SQL and SQL*Plus commands, type them at the SQL prompt and press 
Enter.

Using the Mouse Buttons to Copy SQL Commands in the Application Window
You can use the mouse buttons to copy previously entered SQL commands to the 
current SQL prompt.

To copy a command, highlight it with the left mouse button. While still holding 
down the left mouse button, click the right mouse button. SQL*Plus copies the text 
to the SQL prompt.

Using the Command Keys
The following command keys have special functions in SQL*Plus:

Key Function

Home Top of screen buffer 

End Bottom of screen buffer

Page Up Previous screen page

Page Down Next screen page

Ctrl+Page Up Show page on left of current screen page

Ctrl+Page Down Show page on right of current screen page

Alt+F3 Find

F3 Find next

Ctrl+C Copy text

Ctrl+V Paste text 

Shift+Del Clear the screen and the screen buffer 
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Using the Graphical User Interface
Using the SQL*Plus Menus
This section describes the five menus in SQL*Plus.

File Menu
The File menu contains the following commands:

File Menu 
Command Description

Command Line 
Equivalent

Open The Open command retrieves a previously stored command file.

By default, SQL*Plus looks for a command file with the .SQL 
extension.

not applicable

Save The Save command contains three subcommands: Save Create, Save 
Replace, and Save Append.

SAVE

■ Save Create saves the contents of the SQL*Plus buffer in a 
command file. By default, SQL*Plus assigns the .SQL extension to 
command files. You can specify a different extension in the File 
name text box.

SAVE filename 
CREATE

■ Save Replace replaces the contents of an existing file with the 
contents of the SQL*Plus buffer. If the file does not exist, SQL*Plus 
creates the file.

SAVE filename 
REPLACE

■ Save Append adds the contents of the SQL*Plus buffer to the end 
of the file you specify.

After you save a command file, you can do the following:

■ retrieve the file with the Open command from the File menu

■ edit the file with the Editor command from the Edit menu

■ start or run the file with the START or RUN commands from the 
SQL*Plus command prompt

SAVE filename 
APPEND

Save As The Save As command saves the contents of the SQL*Plus buffer in a 
command file.

By default, SQL*Plus assigns the .SQL extension to command files. 
You can specify a different extension in the File name text box.

SAVE filename

Spool The Spool command contains two subcommands: Spool File and 
Spool Off.

■ Spool File stores query results in a file. By default, SQL*Plus 
assigns the .LST extension to spool files. You can specify a 
different extension in the File name text box. You can edit the 
results with the Editor command from the Edit menu, and print 
the file from a Windows NT or Windows 95/98 text editor.

SPOOL filename
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Using the Graphical User Interface
Edit Menu
The Edit menu contains the following commands:

■ Spool Off turns off spooling. SPOOL OFF

Run The Run command lists and executes the SQL command or PL/SQL 
block currently stored in the SQL buffer.

RUN

Cancel The Cancel command cancels an in-progress operation.

Ctrl+C is the keyboard shortcut for the Cancel command.

not applicable

Exit The Exit command commits all pending database changes and closes 
the SQL*Plus application window.

EXIT

Edit Menu 
Command Description

Command Line 
Equivalent

Copy The Copy command copies the selected text to the Clipboard.

After you copy text to the Clipboard, you can paste the text into other 
Windows applications, such as Microsoft Excel and Microsoft Word.

Ctrl+C is the keyboard shortcut for the Copy command.

not applicable

Paste The Paste command pastes the contents of the Clipboard onto the 
SQL*Plus command line.

Ctrl+V is the keyboard shortcut for the Paste command.

Note: A maximum of 3625 characters can be pasted from the 
Clipboard onto the SQL*Plus command line during a single paste 
operation.

not applicable

Clear The Clear command clears the screen of the SQL*Plus application 
window and the screen buffer.

Shift+Del is the keyboard shortcut for the Clear command.

CLEAR SCREEN

Editor The Editor command contains two subcommands: Invoke Editor and 
Define Editor.

■ Invoke Editor loads the contents of the SQL*Plus buffer into an 
editor. By default, SQL*Plus saves the file to AFIEDT.BUF. You can 
specify a different file name in the editor.

EDIT

■ Define Editor defines the editor that is invoked. not applicable

File Menu 
Command Description

Command Line 
Equivalent
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Using the Graphical User Interface
Search Menu
The Search menu contains the following commands:

Options Menu
The Options menu contains the following command:

Search Menu 
Command Description

Command Line 
Equivalent

Find The Find command searches for a character, a word, or a group of 
characters or words in the SQL*Plus application window. When you 
choose the Find command, SQL*Plus begins the search at the top of 
the displayed screen.

Note: When SQL*Plus reaches the end of the displayed screen, it will 
not automatically continue searching from the top of the SQL*Plus 
screen buffer.

ALT+F3 is the keyboard shortcut for the Clear command.

not applicable

Find Next The Find Next command finds the next occurrence of the search text.

F3 is the keyboard shortcut for the Clear command.

not applicable

Options Menu 
Command Description

Command Line 
Equivalent

Environment The Environment command allows you to set system variables to alter 
the SQL*Plus environment for your current session.

The Environment dialog contains two areas: Set Options and Screen 
Buffer.

SET variable value

Set Options

This area contains a list of variables you can choose in order to 
establish aspects of the SQL*Plus environment for your current 
session, such as the following:

■ setting the display width for NUMBER data

■ setting the display width for LONG data

■ enabling or disabling the printing of column headings

■ setting the number of lines per page

You can make multiple changes to options before clicking OK to 
commit the changes.
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Using the Graphical User Interface
Help Menu
The SQL*Plus application does not contain online help. However, the CD-ROM 
contains the following documentation in both HTML and PDF format:

■ SQL*Plus User’s Guide and Reference

■ SQL*Plus Quick Reference

■ SQL*Plus Getting Started for Windows NT and Windows 95/98 (this guide)

To establish an aspect of the SQL*Plus environment:

1. In the Environment dialog, select a variable from the Set Options 
box.

2. Select the appropriate option buttons and, if required, enter text in 
the text box.

3. Click OK.

Screen Buffer

When you change the Screen Buffer option, SQL*Plus displays a dialog 
to alert you that if you shorten the size of your screen buffer, some 
data may not be displayed on your screen. Click OK if you want to 
proceed.

The Screen Buffer area consists of two text boxes: Buffer Width and 
Buffer Length.

■ In the Buffer Width text box, you can set the number of characters 
that SQL*Plus displays on one line. If you enter a number smaller 
than the length of output data, SQL*Plus truncates the data to 
match the buffer width you specified. The default value of the 
Buffer Width parameter is 100 characters. You can specify from 80 
to 1000 characters on one line.

■ In the Buffer Length text box, you can set the number of lines that 
SQL*Plus displays on the screen. If SQL*Plus displays more lines 
of data than you specify, the remaining lines of data will “wrap 
around” to the top of the screen buffer. The default value of the 
Buffer Length parameter is 1000 lines. You can specify from 100 to 
2000 lines on one screen.

Options Menu 
Command Description

Command Line 
Equivalent
2-8 SQL*Plus Getting Started



Using SQLPLUS.EXE
The Help menu contains one command:

Using SQLPLUS.EXE
SQLPLUS.EXE is used to spawn any SQL*Plus executable that is defined in the 
PLUS_DFLT parameter located in the registry.

SQLPLUS.EXE allows you to run any specified version and mode of SQL*Plus 
when it is started. You can modify the value of PLUS_DFLT, thereby having 
SQLPLUS.EXE spawn the desired version and mode of SQL*Plus.

By default, PLUS_DFLT is set to the last version of the command line interface of 
SQL*Plus installed.

Help Menu 
Command Description

Command Line 
Equivalent

About SQL*Plus Displays the version number and copyright information. not applicable
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Operating System-Specific References

This chapter provides the operating system-specific information that is referenced 
in the SQL*Plus User’s Guide and Reference.

Specific topics discussed are:

■ Access to Sample Tables

■ Automatic Login

■ TIMING Command

■ Interpreting Error Messages

■ Setting Up Your SQL*Plus Environment

■ Sending Results to a File

■ Setting Up the Site Profile

■ @, @@, and START Commands

■ EXIT Command

■ HOST Command

■ SET NEWPAGE Command

■ PRODUCT_USER_PROFILE Table
nces 3-1



Access to Sample Tables
Access to Sample Tables
"Access to Sample Tables" in Chapter 1 of the SQL*Plus User’s Guide and Reference 
discusses the sample data that you must load into your database in order to work 
through the exercises.

To load the data, start SQL*Plus with the user account for working through the 
examples. The SQL*Plus User’s Guide and Reference refers to the user name SCOTT 
with the password TIGER, but you can use any account that has the resource 
privilege.

Enter the following command at the SQL*Plus prompt:

SQL> @ORACLE_HOME\DBS\DEMOBLD.SQL

When you finish working through the examples, you can remove the sample data 
from the database by entering the following command:

SQL> @ORACLE_HOME\DBS\DEMODROP.SQL

Automatic Login
 "Shortcuts to Starting SQL*Plus" in Chapter 2 of the SQL*Plus User’s Guide and 
Reference refers you to this guide for information about automatically logging on to 
SQL*Plus when you log on to your operating system.

When connecting to an Oracle database on the same Windows NT or Windows 
95/98 machine, you can set up SQL*Plus to do an automatic login by following 
these steps:

1. Create an account in the database <PREFIX>USERX for every Windows NT or 
Windows 95/98 user (USERX) who needs access to the database. <PREFIX> is 
the initSID.ora parameter OS_AUTHENT_PREFIX for the database (the default 
is OPS$).

2. After logging on to Windows NT or Windows 95/98 as USERX, you can log in 
as / .

Note:  If you access a database installed on another computer, 
your database administrator should build these tables for you.
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Sending Results to a File
TIMING Command
The section "Collecting Timing Statistics on Commands You Run" in Chapter 2 and 
the sections "SET" and "TIMING" in Chapter 7 of the SQL*Plus User’s Guide and 
Reference discuss how to use the TIMING command and the SET TIMING command 
to record timing data for an elapsed period.

SQL*Plus for Windows NT and Windows 95/98 displays the accumulated time in 
milliseconds.

Interpreting Error Messages
"Interpreting Error Messages" in Chapter 2 of the SQL*Plus User’s Guide and 
Reference refers you to the Oracle8 Error Messages manual and this guide to find error 
codes that begin with the letters ORA.

If you do not find the error code in the Oracle8 Error Messages manual, see the 
Getting Started guide provided with your Oracle database.

Setting Up Your SQL*Plus Environment
"Setting Up Your SQL*Plus Environment" in Chapter 3 of the SQL*Plus User’s Guide 
and Reference describes the LOGIN.SQL and GLOGIN.SQL files.

When you install SQL*Plus for Windows NT and Windows 95/98, LOGIN.SQL is 
copied to the DBS subdirectory of your Oracle home directory.

When you install SQL*Plus for Windows NT and Windows 95/98, GLOGIN.SQL is 
copied to the PLUS80 subdirectory of your Oracle home directory.

If you modify LOGIN.SQL or GLOGIN.SQL, make sure you do not add any ANSI 
escape sequences.

Some Oracle products use a LOGIN file named LOGIN.NEW. If this file exists on 
your computer, make sure you do not use it with SQL*Plus for Windows NT and 
Windows 95/98.

Sending Results to a File
"Sending Results to a File" in Chapter 4 of the SQL*Plus User’s Guide and Reference 
describes the SPOOL command.
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Setting Up the Site Profile
This command is available in the File menu of SQL*Plus for Windows NT and 
Windows 95/98. See the section "File Menu" in Chapter 2 of this guide for more 
information.

When you use the SPOOL command from the graphical user interface or the 
command line interface, SQL*Plus for Windows NT and Windows 95/98 adds .LST 
to the file name if you do not specify an extension.

SQL*Plus for Windows NT and Windows 95/98 does not support the use of the 
SPOOL OUT clause at the command line.

Setting Up the Site Profile
"Setting Up the Site Profile" in Chapter 6 of the SQL*Plus User’s Guide and Reference 
describes the Site Profile, a SQL*Plus command file created by the database 
administrator. This command file is not applicable to the Windows NT or Windows 
95/98 environments.

@, @@, and START Commands
The sections "@ ("at" sign)," "@@(double "at" sign)," and "START" in Chapter 7 of the 
SQL*Plus User’s Guide and Reference describe how SQL*Plus searches for a file when 
you use the @, @@, or START command.

SQL*Plus for Windows NT and Windows 95/98 searches the current default 
directory for the file name that you specify with the @, @@, or START command. If 
SQL*Plus cannot find this file, the program searches a path to find the file.

You can specify the path that SQL*Plus searches by modifying the SQLPATH 
parameter in your registry.

EXIT Command
"EXIT" in Chapter 7 of the SQL*Plus User’s Guide and Reference describes how to use 
the EXIT command to run SQL*Plus command files in batch mode. SQL*Plus for 
Windows NT and Windows 95/98 does not support batch mode.

HOST Command
"HOST" in Chapter 7 of the SQL*Plus User’s Guide and Reference describes how to use 
the HOST command to execute a host operating system command without leaving 
SQL*Plus.
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PRODUCT_USER_PROFILE Table
In SQL*Plus for Windows NT and Windows 95/98, you can access the MS-DOS 
command prompt by entering the HOST command or a dollar sign ($) at the 
SQL*Plus prompt.

To return to SQL*Plus from the MS-DOS command prompt, enter the EXIT 
command.

SET NEWPAGE Command
"SET" in Chapter 7 of the SQL*Plus User’s Guide and Reference describes how to set 
the NEWPAGE system variable, as well as many other system variables.

The SET NEWPAGE 0 command does not clear the screen between pages. Instead, a 
black box appears. This occurs because the text printing APIs do not support the 
formfeed character "/f" on these platforms.

PRODUCT_USER_PROFILE Table
"PRODUCT_USER_PROFILE Table" in Appendix E of the SQL*Plus User’s Guide and 
Reference describes the PRODUCT_USER_PROFILE table, which provides 
product-level security that supplements the user-level security provided by the SQL 
GRANT and REVOKE commands and user roles.

To create this table, you or your database administrator must run the PUPBLD.SQL 
file, which is located in the ORACLE_HOME\DBS directory.

If you are using SQL*Plus for Windows NT and Windows 95/98 with a remote 
database, you may want to install the PRODUCT_USER_PROFILE table on the 
remote database. To do this, run PUPBLD.SQL on the server directly. Or, you can set 
the LOCAL parameter in your registry to point to the remote database and then run 
PUPBLD.SQL.
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Customizing Operating System Parameters

This chapter describes how to customize your SQL*Plus configuration by changing 
parameters in the registry.

Specific topics discussed are:

■ Using the Registry

■ Parameter Descriptions

Warning: Only advanced users should change the registry.
eters A-1



Using the Registry
Using the Registry
When you install Oracle products for Windows NT or Windows 95/98, Oracle 
Installer adds relevant parameters to the registry. You can examine these parameters 
by running one of the following programs:

■ REGEDT32.EXE (under Windows NT)

■ REGEDIT.EXE (under Windows 95/98)

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE subkey contains the Oracle 
parameters.

See the registry’s online help for instructions on how to edit the parameters.

If you change the value of an Oracle parameter or add a parameter to the registry, 
the change will take effect whenever SQL*Plus executes a procedure that uses the 
parameter.

Parameter Descriptions
This section describes the registry parameters that are relevant to SQL*Plus for 
Windows NT and Windows 95/98 (the parameters reside in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\).

PLUS80
Default Value: ORACLE_HOME\PLUS80

Valid Values: any directory on any drive

This parameter specifies the location of the SQL*Plus files, including the 
GLOGIN.SQL file. In addition to searching the directory specified by PLUS80, 
SQL*Plus also searches the current directory for SQL*Plus files.

The first four characters of this parameter, PLUS, refer to SQL*Plus. The remaining 
characters correspond to the current version of SQL*Plus. Subsequent versions of 
SQL*Plus may use a different version number (for example, PLUS81) to enable you 
to keep multiple versions of SQL*Plus on your computer.
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PLUS_DFLT
Default Value: PLUS80

Valid Values: any SQL*Plus executable, such as PLUS80 or PLUS80W

This parameter specifies the SQL*Plus executable to be spawned when 
SQLPLUS.EXE is started.

SQLPATH
Default Value: ORACLE_HOME\DBS

Valid Values: any directory on any drive

This parameter specifies the location of SQL scripts. In addition to searching the 
directory specified by the SQLPATH parameter, SQL*Plus also searches the current 
directory for SQL scripts.

When you set the SQLPATH parameter, directories can be concatenated with a 
semicolon (;). For example:

C:\ORANT\DATA;C:\ORANT\DBS

Note: SQL*Plus uses the PLUS80 parameter to specify the location 
of the GLOGIN.SQL script. Refer to "PLUS80" earlier in this 
appendix for more information.
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Symbols
$ command, 3-5
@ command, 3-4
@@ command, 3-4

A
access to sample tables, 3-2
AFIEDT.BUF, 2-6
ANSI escape sequences, warning about, 3-3

B
basic concepts, 1-2
batch mode, not supported, 3-4
block, defined, 1-2
buffer, 2-5, 2-8

C
cancelling an in-progress operation, 2-6
clearing your screen, 2-6
command files

opening, 2-5
saving, 2-5

command keys, 2-4
command line interface, 2-2
command, defined, 1-2
copying text, 2-4, 2-6

D
DEMOBLD.SQL file, 3-2
DEMODROP.SQL file, 3-2
demonstration tables, 3-2
documentation, available on CD-ROM, 2-8

E
Edit menu, 2-6
editor

defining, 2-6
invoking, 2-6

Environment command, 2-7
error messages, interpreting, 3-3
EXIT command, 3-4
exiting SQL*Plus, 2-6

F
File menu, 2-5
finding text, 2-7

G
generic documentation references

@ command, 3-4
@@ command, 3-4
error messages, 3-3
EXIT command, 3-4
HOST command, 3-4
installing SQL*Plus, 1-3
PRODUCT_USER_PROFILE Table, 3-5
running DEMOBLD and DEMODROP, 3-2
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Sending Results to a File, 3-3
SET NEWPAGE command, 3-5
setting up SQL*Plus using LOGIN and 

GLOGIN, 3-3
Site Profiles, 3-4
SQL*Plus automatic login, 3-2
SQL*Plus Help, 2-8
starting SQL*Plus, 2-2
TIMING command, 3-3

GLOGIN.SQL file, 3-3, A-3
graphical user interface

menus, 2-5
starting, 2-2

H
Help menu, 2-8
HOST command, 3-4
HTML documentation, 2-8

I
installing, 1-3

L
LOCAL parameter, 3-5
LOGIN.NEW file, warning about, 3-3
LOGIN.SQL file, 3-3

M
mouse, using to copy commands, 2-4
MS-DOS, accessing from SQL*Plus, 3-5

O
Options menu, 2-7
ORA error messages, 3-3
Oracle home, defined, ix
overview, 1-2

P
parameters

PLUS_DFLT, 2-9, A-3
PLUS80, A-2
SQLPATH, 3-4, A-3

pasting text, 2-6
PDF documentation, 2-8
PLUS_DFLT parameter, 2-9, A-3
PLUS80 parameter, A-2
PRODUCT_USER_PROFILE table, 3-5
PUPBLD.SQL file, 3-5

Q
query results, defined, 1-2
query, defined, 1-2

R
registry, using, A-2
report, defined, 1-2

S
sample tables, 3-2
Screen Buffer area, 2-8
Search menu, 2-7
security

PRODUCT_USER_PROFILE table, 3-5
SET NEWPAGE command, 3-5
Set Options area, 2-7
SET TIMING command, 3-3
shortcuts to starting SQL*Plus, 3-2
Site Profile, 3-4
SPOOL command, 3-3
spool files, 2-5, 3-3
SPOOL OUT clause, not supported, 3-4
SQL*Plus

basic concepts, 1-2
command line interface, 2-2
graphical user interface, 2-2
installing, 1-3
menus, 2-5
multiple versions, 1-3, A-2
overview, 1-2
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shortcuts to starting, 3-2
SQLPATH parameter, 3-4, A-3
SQLPLUS.EXE, 2-9
START command, 3-4
system variables, setting, 2-7

T
table, defined, 1-2
tables, sample, 3-2
text editor

defining, 2-6
invoking, 2-6

TIMING command, 3-3
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